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HARDWARE REQUIREMENT AND SOFTWARE INSTALLATION

Hardware Requirement

- S32G-VNP-RDB3
- S32 Debug Probe
- AD/DC power supply

- Serial port cable for UART example

Software Installation
- Install S32DS 3.5 according to S32G-VNP-RDB3 Software Enablement Guide
- Install SW32G_RTD_4.4 4.0.0 _D2210(RTD) according to S32G-VNP-RDB3 Software Enablement Guide
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HANDS ON UART: OBJECTIVE

— How to import the UART example into S32DS

— How to configure the clock of UART via S32DS

— How to configure the UART module via S32DS

— How to debug the UART example with S32 debug probe
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HANDS ON UART: IMPORT UART EXAMPLE PROJECT

Open S32 Design Studio, go to "File -> New -> S32DS Project From Example". Select
"Linflexd _Uart_Ip_Example S32G399A_ M7" example, click on "Finish". The project should now be copied into

the current workspace.

workspaceS32DS.3.4 - 532G274Astandbymode/src/S32G_Standby.c - 532 Design Studio for S32 Platform
Edit Source Refactor Navigate Search Project ConfigTools Run Window Help

r New Alt+Shift+N > -~ S32DS Project from Example Ctri+Alt+E |
®nen File... & 5320 Library Project Ctri+Alt+L
. JOpe} Projects from File System.. S$32DS Application Project Ctri+Alt+A
nt Files > & Makefile Project with Existing Code
Close Ctrisw [ C/C++ Project
Close Al Ctrisshiftew | Project-
& Convert to a C/C++ Project (Adds C/C++ Nature)
65 Source Folder
Folder
¢ Source File
n Header File
File from Template
™ Rename.. F2 @ Cdass
Refresh FS' | Example...
Convert Line Delimiters To >
I Other.. Ctrl+N

= Linflexd Uart Ip Example S32G274A M7
| ' Linflexd Uart Ip Example 53263994 M7 |
T Uinflexd_UarlIp_Example_S32R45_ M7
(& Uart_Example_532G274A_M7
& Uart_Example_S32G399A_M7
& Uart_Example_S32R45_M7
~ = 532 RTD AUTOSAR 4.4 D2105 Example Projects
~ & Uart Examples

=)

3 Linflexd_Uart_Ip_Example_S32G274A_ M7
& Linflexd_Uart_Ip_Example_S32R45_ M7
e Uart_Example_S32G274A_M7

P canac s

[ 53205 Project from Example. m] x ‘
Create 532DS Project from Example
Project name: |Linflexd_Uart_Ip_Example_S32G399A_ M7
uart
Examples: Description:
~ & Uart Examples 1. Example Description ~

This is a simple application which shows the usage of
Linflexd_Uart driver.
1.1 The application software functionality
- Clock_lp_Init();
Initialize the Clock used by the application
using the Mcu driver.
- ImtCtri_lp_Enablelrq();
- IntCtrl_lp_InstallHandler();
Install the ISR for the Uart
- Uart_Setup_Pins();
Initialize pins
- Linflexd_Uart_Ip_lnit();
Initialize LINFlexD module for UART usage
- Linflexd_Uart_Ip_Deinit();

@ Canc

- = Linflexd_Uart_lp_Example_532G399A_M7: Debug_RAM

=)

@ Project_Settings
& src

nil Includes :

/.‘:

The "Linflexd Uart Ip_Example S32G399A M7" example is a simple application which shows the usage of

UART driver.

~\ “Hello”

P
“Hello World”

<

S32G Debug Probe

A\ Scrial port cable

532G-VNP-RDB3

J48 JTAG
UART1




HANDS ON UART: PIN CONFIGURATION

Open the Pins configuration tool. According to schematic of RDB3, configure pins routing. By default, this

example already has corresponding pin routing configuration.

[ = treca varttp bar - oo wrm e

= Inci uaes
& Project_Settings
> @src

@ include

#d

# Dashboard ©

* Project Creation

2 S32DS Application Prc

B S320S Library Project
* Build/Debug
& Build (All)

« Clean (Al

% Debug

~ Settings

& Project settings
% Build settings
% Debug settings
* Miscellaneous
* Getting Started

# Quick access

B Linflexd Uart Ip
& Port_ToggleLed_S32C
& SPD_200_S32G399_\
&5 SPD_200_S32G399A. _

ictony
|-mwm

Go Into

Open in New Window
Show In
Show in Local Terminal
& Copy
¥ Delete
T Paste
™ Rename...
Source

Move..

i Import...
=2 Export...

Build Project
Clean Project

! Refresh
Close Project
Close Unrelated Projects
Build Targets
Index
Build Configurations
Build path
Build Configurations Explorer
Attach/Detach SDKs...
Manage SDKs...

Migrate...

Show in Remote Systems view

© RunAs

% Debug As

Alt+Shift+W

Ctrl+C
Delete
Ctrl+V

F2

F5

>

>

>

v

E Pins % BN Peri.. ¥ Pow...

Team
Compare With
Configure
Source

¥ Validate

Properties

Alt+Enter

v v v viv
-8 W% <« S

Clocks
Open Pins

(o]

|

Ope
Open DCD

Open IVT

Open QuadSPI

Open DDR

Open eFUSE

Import Configuration (*.mex)
Manage SDK Components

~ O 4¥ package [Pins Bottom] # &¥ Expansion Header

QQOoNEESH=E= O

N
g80 wr eee 5@;;% e e e e e e e
pn Pinname  Label A IERRRERERRRERRRERERERE
K12 VSSSSQ A HE B R R EDR " B R EEEEREETSR l:‘ ><
L12 VDD451 “— " B BN EEBN " B B BB B R EEBN
YIM12  VSS360 — Dbl bsiabalalaialal All signals on pin [U12]:
IN12 VDDA452 - Z Pl | [ BOOT:rcon 4
P2 Vss3et | Z I -0 o0
R12 VDD453 o EE EEEEEEENEENEENEENEEERN .|_|NF|e)(_1txd
MT12 VDD IO A.. A : : : : : : : : : : : : : : : : : 3 [IPFE_MACT:rx_err
Mu12 . el | [ ISIUL2 0:gpio, 13
V12 vss3eo — IR 5705
.W12 _— L BN | " E E R E N E N EEEETBm
| _— | I | HE B B R ER HE B R R RN
Yé%lepci1r? and select correct signal = Soooooocoogod
AA12PE_‘I4 9 - — . nooooc Done
VIAB12 VSS363 N = e = e —
AC12V55364 v e " E RN H E B E B N BN EBHN — =
< > e >
£ Routing Details =0
‘Pins‘ ‘ Signals ‘ ‘ P type filter text
Routing Details for...
i i i Lahel Identifier_Pawergraun _ Direction Output Buffer Open Drain _Input Buffor
R Linrlex 1 xd < [W12]PB_00 n/a VDD IO A(0V) Input  Disabled ~ Disabled  Enabled
U12 LINFlex 1 txd -> [U12] PA_13 n/a VDD IO A (0V) Qutput  Enabled Disabled Disabled
Configure pin’s attributes 6 A



HANDS ON UART: CLOCK CONFIGURATION 1

v C A Bt B P i FAASAAAA AAT. M _i.... MASS
~|= Linflex

.

}

Open the Clocks Diagram: :
- Right-click the Project @
- Select S32 Configuration Tools
- Select Open Clocks

& Proj

) %[

n INCH

Go Into

Open in New Window

r Show In

Show in Local Terminal

Copy

Delete

Paste

™ Rename..
Source

s Import...

w2 Export.

Build Project

Clean Project

Refresh

Close Project

Close Unrelated Project

Build Targets
Index
Build Configurations

Build path

Build Configurations Explorer
SDKs

Migrate...

Show in Remote Systems view
©Q RunAs
1 Debug As

Alt+Shift+W

Ctri+C
Delete
Ctri+V

F2

F5

>

>

>

Histary
l # 532 Configuration Tools

0 Pine

Team
Compare With
Configure
Source

v Validate

Properties

Alt+Enter

Open Clocks

SUM%G <{S|e

Open Perip’~
Open DCD

Open IVT

Open QuadSP!

Open DDR

Import Configuration (*.mex)

anage SDK Components



HANDS ON UART: CLOCK CONFIGURATION 2

Open the Peripheral Clock View, and double-click the Lin module. The Clocks Diagram will show the clock tree of
the LinFlexD. The default clock configuration of UART is 48 MHZ which comes from FIRC directly.

#0v.] ©Ope.. = @ Co.. BRe.. EDe.. Bl.. ~ F Ll ﬂ'ﬁ
SIRC CLE 2kl
E E !
Clock Name Enable Source Divider Freq FIRC gm Wiz 1 ﬁgﬂirﬁﬁ? % EE
l1C3_CLK b XBA.. /1 133. 12 kHz CORE _PLL DFS1 % E% E EF i E E’E
IC4_CLK M XBA. /1 133 Slov IRC ) %ﬁﬁ‘ ﬁﬁ%
LBISTO_CLK 4 COR. /16 50N B I PR B R p: g
LBIST1_CLK o COR.. /16 50N tt 1N, -‘m-'f'-"]Q_‘ | BEENAC BT TF 14 B
LBIST2_CLK % COR. /16 50N TmmITIIITIIIISo oo MORRHLORS i FRRACL EXT REF i
LBIST3_CLK & COR.. /16 50\
LBIST4_CLK & COR.. /16 50\
LBISTS_CLK & COR.. /16 50N\ A
LBIST6_CLK & COR.. /16 50N\ » I,f' LIN ELEE MH
LBIST7_CLK & COR.. /16 50N\ LING CLE “
TINO_CLK i FIRC.. /1 48N PERIPHPLL_PHI3 CEE WHz
LINT_CLK & FIRC.. /1 48N\ : . :
LIN2_CLK % FRC.. /1 48N\ E;‘gﬁtith ! I T_}EEEZ MHz
OCOTPO_CLK M FIRC.. /1 48N\ - 15 45 MHz
PFEMACO_ RX_CLK [ FIRC.. /1 48N\ DT 1 E
PFEMACO_TX CLK [ FIRC.. /1 48N\
PFEMACT RX_CLK [ FIRC.. /1 48N\
PFEMACT TX CLK [ FIRC.. /1 48NV




HANDS ON UART: UART CONFIGURATION 1

wl Includes

Open the Peripherals Diagram: e | Golmo

v @3 sic Open in New Window

— nght'C“Ck the PrOjeCt > [@ mainc Show In Alt+Shifts W >

@5 include Show in Local Terminal ¥
&d '® Copy Ctri+C

- Select S32 Configuration Tools B e Vo 3 ot S
I Paste Ctrl+V
™ Rename.. F2

- Select Open Peripherals

Build Praoject

Clean Project

Refresh F5
Close Project

Close Unrelated Project

Build Targets ?
Index »
Build Configurations H

Build path >
Build Configurations Explorer

SDKs

Migrate..

Show in Remote Systems view
© PRun As »
1¢ Debug As >
Restore from Local History...

Il 532 Configuration Tools 4 ® OpenPins
Team 1 _Open Clocks
Compare With > & Open Peripherals
Configure @ Open DCD Open Peripheral
Source 5 | = OpenINT
¥ Validate = Open QuadsSPI
© Open DDR
Properties Alt+Enter

Import Configuration (*.mex)
Manage SDK Components




HANDS ON UART: UART CONFIGURATION 2

The Components shows all drivers which used by this example, the Linflexd Uart Component includes the
configuration of UART driver

UART module configuration :

B's &

Custom name |

Preset Custom.. *

Preset Custom.. ¥

B ¥ = = 9 (¢ Linflexd_Uart =2
& Components © ' Peripherals ] )
Linflexd Uart Configuration (privers)
T}:':l"": BT Text u Tl- Name | Linflexd_Uart
Mode LINFLEXD UART Mode
MCAL o
Name | ConfigTimeSupport GeneralConfiguration | UartGlobalConfig
Drivers 4
Name UartGlobalConfig
SintCtri_lp I Linflexd_Uart Sosif_1 3Siul2_Port “ UartChannel  +
UartChannel_0 Name UartChannel_0
UartHwChannel LinflexD_1

UartClockFunctionalGroupRef BOARD_BootClockRUMN
~ DetailModuleConfiguration

Name |DetaiIModuIeConriguratuon

- Configure Uart Hardware Channel —yl| | Desire Baudrate LINFLEXD_ UART BAUDRATE.9600

Uart Asynchronous Method LINFLEXD_UART_IP_USING_INTERRUPTS

- Configure Baudrate —

- Configure Uart Parity Enable option \
Uart Parity Enable |

- Configure Uart Stop Bit Number
- Configure Uart Word Length —

\Uan Stop Bit Number LINFLEXD_UART_IP_TWO_STOP_BIT

g = == | Jart Word Length LINFLEXD_UART_IP_8_BITS

10



HANDS ON UART: UPDATE CODE

vV

Generate code method: =

1. Open the view of any configuration tool, like
Pins, then click Update Code (ensure desired
project is selected)

2. The Update Files window pops up. It shows

- | @ Linflexd_Uart_lp_Example_S32G39' @

v | '8 Functional Group VS_0

the detailed update information. Click OK button.

3. The configuration .c and .h files will be
generated in "generate" folder.

ﬁ Update Files
Generated file I Status "‘
- Pins D emor
=M board,
E Siul2_Port_lp_Clg.c B create
[ Siul2_Port_lp_Cfg.h B create
- [ Clocks @ eror
= [ generate',
-4 include’,
M Clock_Ip_BOARD_InitPeripherals_PBefa.h  [Bl create
M Clock_lp_Cfg.h B create
Clock_lp_Cfg_Definesh Bl create
- [ generate’,
= srcy
FRrieal: ls DEvADM Baiofelebk saxla P =l = | ———— —

Options @
[] Always show details before Update Code _“ Cancel

~ 1 Linflexd_Uart_Ip_Example S32G399A_M7: Debug RAM

&) Includes

& Project_Settings
& RTD

&5 board

v (@ generate

v @& src
1€ Clock_Ip_BOARD_InitPeripherals_PBcfg.c
\8 Clock_Ip_Cfg.c
g IntCtri_lp_Cfg.c
¢ Linflexd_Uart_Ip_Sa_VS_0_PBcfg.c
¢ Oslf_Cfg.c
v & generate/include
in Clock_Ip_BOARD_InitPeripherals_PBcfg.h
(8 Clock_Ip_Cfg_Defines.h
in Clock_Ip_Cfg.h
[N IntCtrl_lp_Cfg.h
{8 IntCtri_lp_CfgDefines.h
in Linflexd_Uart_Ip_Cfg.h
[N Linflexd_Uart_Ip_Defines.h
in Linflexd_Uart_Ip_Sa_VS_0_PBcfg.h
{8 modulesh
[8 Oslif_ArchCfg.h
in Oslf_Cfg.h
[n Siul2_Port_Ip_Defines.h
v (& generate/src
lg Clock_Ip_BOARD_InitPeripherals_PBcfg.c
lg Clock_Ip_Cfg.c
g IntCtrl_Ip_Cfg.c
lg Linflexd_Uart_Ip_Sa_VS_0_PBcfg.c
1€ Oslf_Cfg.c
b src

MRS

11 VAN



HANDS ON UART: APPLICATION CODE 1

Dissecting the main.c

‘int main(void)

{

/* Write your code here */

/* Buffer to store the received message */

uint8 rxBuff[RX_MSG_LEN];

uint32 varRemainingBytes;

Linflexd Uart_Ip StatusType transmitStatus = LINFLEXD UART_IP_STATUS_ERROR;
Linflexd Uart_Ip StatusType receiveStatus = LINFLEXD UART_IP_STATUS_ERROR;
/* Initialize and configure clocks

. = Setup system clocks, dividers

. . see clock manager component for more details

)

Clock_Ip Init(&Mcu_aClockConfigPB[0]);

/* Interrupts controller initialization */
IntCtrl_Ip_Init(&IntCtrlConfig 0);
IntCtrl_Ip_ConfigIrqRouting(&intRouteConfig);

/* Initialize pins */
Siul2 Port_Ip_Init(NUM_OF CONFIGURED_PINS@, g pin_mux_InitConfigArr@);

/* Initialize LINFlexD module for UART usage */
Linflexd Uart_Ip Init(LINFLEXD_INSTANCE, &Linflexd Uart_Ip xHwConfigPB_1 VS 0);

MCU clock initialization and Interrupt initialization

Initialize pins

Initialize LINFlexD module

/* Send the greeting message to console */
Linflexd_Uart_Ip_ AsyncSend(LINFLEXD_INSTANCE, (uint8*)WELCOME_MSG, strlen(WELCOME_MSG));

/* Wait for data send */

while(Linflexd Uart_Ip_ GetTransmitStatus(LINFLEXD_INSTANCE, &varRemainingBytes) == LINFLEXD UART_IP_STATUS_BUSY);

transmitStatus = Linflexd Uart_Ip_GetTransmitStatus(LINFLEXD_INSTANCE, &varRemainingBytes);

Send the greeting message to console

12 A



HANDS ON UART: APPLICATION CODE 2

Dissecting the main.c

/* Infinite loop */
for( ;5 )
{

/* Get the message sent by user from the console, using a-sync method */

Linflexd Uart Ip AsyncReceive(LINFLEXD INSTANCE, rxBuff, strlen("Hello"));
/* Wait for data receive */ Receive data from user

while(Linflexd Uart Ip GetReceiveStatus{LINFLEXD INSTANCE, &varRemainingBytes) == LINFLEXD UART IP STATUS BUSY);

receiveStatus = Linflexd Uart Ip GetReceiveStatus(LINFLEXD INSTANCE, &varRemainingBytes);

/* If the user typed "Hello", reply with the "Hello world!” message again */
if(stremp((char®*)rxBuff, "Hello") == @)
{

Linflexd Uart Ip AsyncSend(LINFLEXD INSTANCE, (uint8*)MSG, strlen(MSG));
f* Wait for data send */
while(Linflexd Uart Ip GetTransmitStatus({LINFLEXD INSTANCE, &varRemainingBytes) == LINFLEXD UART IP STATUS BUSY);

break;
} Echo the received data back

else

{
Linflexd Uart_Ip_AsyncSend(LINFLEXD_INSTANCE, (uint8*)ERROR_MSG, strlen(ERROR_MSG));

/* Wait for data send */
while(Linflexd Uart_Ip_ GetTransmitStatus(LINFLEXD_INSTANCE, &varRemainingBytes) == LINFLEXD UART_IP STATUS_BUSY);

break;

13



HANDS ON UART: BUILD AND DEBUG 1

Build the target :
Right-click the Project
Select Build Project
Print Build information on Console window
Linflexd_Uart_Ip_Example _S32G399A M7.elf is

generated

ril
]

< |
=

BB G

o0

"

£
(B

[

it Project Explorer =2
~ 1= Linflexd_Uart_Ip_Example §32-~""" === =+ ===*

Includes
Project_Settings
RTD

board

generate
generate/include
generate/src

SIC

[£ main.c

EN=3 ¥

MNew
Go Into

Open in New Window
Show In
Show in Local Terminal

Copy
Delete
Paste
Rename...
Source

Move...

Import...
Export..

Alt+Shift+W

Ctri+C
Delete
Ctrl+V

F2

>

>

£
B 6

Build Project

Clean Project
Refresh

F5

o Project Explorer

« 1% Linflexd_Uart_Ilp_Example 532G399A_M7: Debug RAM
+ 4 Binaries

% Linflexd Uart Ip Example 532G399A M7.elf - [arm/le
3 Includes

&,

Project_Settings
RTD

board

i generate

2 generate/include
£ generate/src

sIC

[€ main.c

» Debug_RAM

BB G

F

R

Q) Console 2
CDT Build Console [Linflexd_Uart_Ip_Example_S32G399A_M7]
R Ry &7

T ATITICU UUIIUIIE ST T U JeTCICTeaT, OOt TGP —COUT S TaI COPICwT TS
Finished building: ../Project_Settings/Startup_Code/system.c

Building target: Linflexd_Uart_Ip_Example_S32G399A_M7.elf

Invoking: Standard S32DS C Linker

arm-none-eabi-gcc -o “"Linflexd Uart_Ip_Example_S32G399A_M7.elf" "@Linflexd_Uart_Ip_Example_S32G399A_M7.args"
Finished building target: Linflexd Uart_Ip_Example_S32G399A_M7.elf

Invoking: Standard S32DS Print Size

arm-none-eabi-size --format=berkeley Linflexd_Uart_Ip_Example_S32G399A_M7.elf
text data bss dec hex filename

292496 @ 12289 304785 4a691 Linflexd Uart_Ip_Example_S32G399A_M7.elf

Finished building: Linflexd_Uart_Ip_Example_S32G399A M7.siz

16:33:41 Build Finished. @ errors, © warnings. (took 18s.834ms)

14 A



HANDS ON UART: BUILD AND DEBUG 2

Debug configuration setting:
Connect the S32 Debug probe with PC and RDB3
Click on target project

Go to debug configuration:
- Right-click the Project
- Select the Debug As

- Click on Debug Configurations

Select the target device and core as S32G399A M7 0
Select target S32 Debug Probe

T v [ e
i Binari o Int
0 Into
wiF Includ
& Proj Open in New Window -
0Je P B Debug Cenfigurations (] x |
& RID Show In Alt+Shift+W > :
2 board Show in Local Terminal > Create, manage, and run configurations @-
a
= 9ENET B Copy Ctrl+C
-
< 9ENET ¥ Delete Delete 3
S gener = past CtrlsV ERABXIBY - Name: Linflexd_UartIp_Bxample_S32G399A_M7_Debug_RAM_S32Debug
- | asie T+ -
o ere = R P2 type filter text Mai # Startup % Source| ] Common | 1} SVD Support| 88 OS Awareness' & Trace and Profile
Deb Bl [€] C/C++ Application Hardware ~
< Uebw  Source > [E] C/C++ Remote Applicat
.  C/C-+ Remote Appication Device: 532G399A Core: M7.0 I Select device and core
= Move © Eclipse Application
=, [E] GDB Hardware Debugging Initialization script: _S[S3ZDSJNITIALIZATION}CR\PTSﬁD\R}Is}?g3mc,r’532§Jxxigenen(7bareboard py Browse.. |Variables...
% iz Import.. [ GDB PEMicro Interface Debugging [ Initial core
i Export. [€] GDB SEGGER J-Link Debugging -
_ i #& Launch Group Debug Probe Connection
Build PrOJECt ¥ Launch Group (Deprecated) Interface: $32 Debug Probe - USB ~
i L h fi
Clean PI'DJ ect T AR L USB device: 00:04:91.06:6d:1e - 532 Debug Probe ~ | Refresh Test connection
Refresh F5 v~ 532 Debugger
Linflexd_Uart_Ip_Example_S32G399A_M7_Debug_RAM_S32Debug Hostname or IP:
Close Project TP
] UE Target Communication Speed
Close Unrelated Project VLAB Simulator Debugging JTAG Speed (KHz): [16000 Timeout: (30
pee: 7): imeout: s
Build Targets > [ Delay after reser: 0 ms
Index ’ GDB Server
Build Configurations » [ Launch server
Build path 3 Server port number| 45000 |
. . [JEnable lo
Build Configurations Explorer 9
GDB Client
SDKs '
R Executable: | ${532D5_GDB_ARM32_PY] Select Browse.. |Variables..
Migrate... d
Commands:
Show in Remote Systems view
10 fis > e
i As ] 1 1 Local C/C++ Application F— Apply
- - - Filter matched 13 of 22 items
Restore from Local History... B 2s532D5C/C++ Application
» "
@ 532 Configuration Tools ' Debug Configurations.. I @ o
Team >

15



HANDS ON UART : DEBUG AND RUN

Power on the RDB3, click on "Apply", then click on "Debug". The view will switch to the Debug Perspective,
and you can use the controls to control the program flow.

Debug Probe Connection

Interface: $32 Debug Probe - USB hd
USE device: 00:04:91:.06:6d:1e - 532 Debug Probe -
Hostname or IP:

Target Communication Speed

JTAG Speed (KHz): @ Timeout: E 5

[] Delay after reset: 0 ms

GDB Server
[] Launch server

Server port number® | 45000
[[] Enable log

< : >
Revert Apply

[ Debws J  Close

File Edit Source Refactor Navigate Search Project ConfigTools Run FreeRTOS Window Help

N | i I:Qix|> o m N3

it IR - O Ry ™S 5 - vioGOw v|re

1# Debug =% o
= 8 i=

v Linflexd_Uart_Ip_Example_S32G399A_M7_Debug_| _

v 5% Linflexd_Uart_Ip_Example_S32G399A_M7.elf [1
v @ Thread #1 1 [core: 0] (Suspended : Breakpoi
= main() at main.c.75 0x340001e0
wi C:/NXP/S32DS.3.4/532DS/tools/gdb-arm/arm3
wi S32 Debugger
wi Semihosting

ig mainc &

main()

int main(void)
{

* Write your code |
* Bu to store the rec
uint8 rxBuff[RX_MSG_LEN];
uint32 varRemainingBytes;
Linflexd_Uart_Ip_StatusType transmitStatus = LINFLEXD_UART_IP_STATUS_ERROR;
Linflexd Uart_Ip StatusType receiveStatus = LINFLEXD UART_IP_STATUS_ERROR;

and configure clocks

fer

Initialize
2 5

ys
clock manager component for more details

C iock_Ip_Init (&cu_aClockConfigPB[0]);
Interrupts controller initialization *

IntCtrl_Ip_Init(&IntCtrlConfig 0);

IntCtrl_Ip_ConfigIrgRouting(&intRouteConfig);

* Initialize pins */

Siul2_Port_Ip_Init(NUM_OF_CONFIGURED_PINS®, g_pin_mux_InitConfigArr@);

16 4



HANDS ON UART: TEST RESULT

Check the test result: B
Connect UARTL with PC and RDB3 e bosea 11 grees you 15 v son et
Open Serial terminal like Tera Term and configure the serial port @

Now you can begin typing:

Hello World!

Click on the Resume option in Debug view

The Serial terminal will print messages

Then input "Hello" in step 3
UART1 will output “Hello World!” back f

L ) o ) ¥l COMG - Tera Term VT - [m] X
Project ConfigTools Run Window Help File Edit Setup Control Window Help
| o R | i | & ~H Q- Q- This examplg is an simple.e(ho using ‘Limcle)'(d UART
The board will greet you if you send 'Hello
Port: COM6 v Now you can begin typing:
speed: 9600 d 50 * - startup asm routine
Data: 8 bit Cancel 51 ¥ _ main ()
Parity: none v 62 */
Stop bits: 1 bit v Help 53=int main(void)
Flow control: none v Bl {
] 85 /* Write your code here */
fransmitcelay 56 /* Buffer to store the received message */
0 hi 0 li —— .
TR REEEnE 57 uint8 rxBuff[RX_MSG_LEN];
T T 58 uint32 varRemainingBytes;
evice Friendly Name: erial Po P . -
Device Instance ID: FTDIBUSWID_0403+PID_6001+AUD3RVOF 89 Linflexd Uart_Ip_StatusType transmitStatus
Device Manufacturer: FTDI 0 - - _
P e asErD] 70 LlnFlexd_l:IaPt_Ip_StatusType r“:_acewestatus =
iAo LA 718 /* Initialize and configure clocks
river Version: 2.12.28.] —_— . .
72 - Setup system clocks, dividers
< 73 - see clock manager component for more
74
75 Clock_TIp_Init(&Mcu_aClockConfigPB[@]);
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HANDS ON ETH - OBJECTIVE

—How to import the ETH example into S32DS

—How to configure the clock of ETH via S32DS

—How to configure the port of ETH via S32DS

—How to use the ETH module to transmit/receive ETH frame
—How to debug the ETH example using S32 debug probe

19
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HANDS ON ETH: IMPORT ETH EXAMPLE PROJECT

Open S32 Design Studio, go to "File -> New -> S32DS Project From Example". Select
"Gmac_Ip_InternalLoopback S32G399A M7 " example, then click on "Finish". The project is copied into the

current workspace.

workspace$32DS.3.4 - 532 Design Studio for 532 Platform

File Edit Source Refactor Navigate Search Project ConfigTools Run Window Help

New Alt+Shift«N > = S32DS Project from Example Ctri+Alt+E
Open File.. % S320S Library Project Ctri+Alt+L
2 Open Projects from File System.. $32DS Application Project Ctri+Alt+A
Recent Files > & Makefile Project with Existing Code
C/C++ Project
™ Project.

& Convert to a C/C++ Project (Adds C/C++ Nature)
Source Folder
Folder

¢ Source File

n Header File
File from Template

™ Rename.. R @ Cdass
pefice: B Example...
Convert Line Delimiters To >
I Other. Ctri+N

name: |Gmac,|u,\mevmmenazk,sszmsg;\,w I T _5 Gl'nac_|p_|r‘IIEFI'ia|LDODD&CLS3ZG399H_M?: DEbug_RﬁM I
ril Includes

= Project_Settings

L

This “Gmac_Ilp_InternalLoopback S32G399A M7” example demonstrates the GMAC transmission and
reception in internal loopback mode. The ETH frame is transmitted back directly through GMAC, and the frame

will not be transmitted to PHY.

S32G-VNP-RDB3

GMACO

<_

) g eUDDERECEL] TEREESNIEEE 4
Eth|Frame KSZ9031
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HANDS ON ETH : PORT CONFIGURATION

Iv 5 Gmac_lp_IntemalLoop R I 5

») Includes

Pins configuration setting:

Right-click the Project B G compe 05 @ Copy

¥ Delete Delete
T Paste Ctri+V

Select S32 Configuration Tools " Rename. 2

Source >

Select Open Pins e

s Export..

Go Into

Open in New Window
Show In

Build Project

Clean Project

Refresh F5
Close Project

Close Unrelated Project

Configure pins to provide the external clock to Tx, Rx signals

Build Targets >
Index >
RAs0. 0 MACO_TX_CLK P20 Build Configurations >
P16  RGMILA_TXC R347 "0 —7 GWACU_TX_EN uz3 | PE_02GMACO_TX_CLK/PFE_MAC1_TX_CLK Y =
P16 RG \'1||_H_T>(_CTL H351;\/\-/U / (j[-_q_ﬁ;_;(_::| ){E-:_J T23 PE_U'&'GMP\CU_TX_EWPFE_WC"_T)(_EN Build Configurations Explorer
P16 AGMILA_TXDO R348° .0 7 SMACT TXDT Too | PE_04/GMACO_TXDO/PFE_MAC1_TXDO SDKs
P16  RGMI_A_TXD1 R3ag" " 0. GRACT TRDZ Uz5 | PE_OS/GMACO_TXD1/PFE_MAC1_TXD1 Migrate..
P16  AGMILA_TXD2 RN GMACO TXDS T57 | PE_0&/GMACO_TXDZ/PFE MAC1_TXD2 PSS AN~ I~
P16 AGMILA_TXD3 / PE_07/GMACO_TXD3/PFE_MAC1_TXD3 © RunAs >
i MACO_RX_CLK R21 # Debug As >
P16 RGMIA RXC 3 g§§1._ A /’Smuu e Ro3-| PE_08/GMACO_RX_CLK/PFE_MAC1_RX_CLK R e
P16 RGMI_A_RX_CTL % /ﬂ3353\ W GWACT HEDO Pig | PE_O9/GMACO_RXDV/PFE_MAC1_RXDV ® $32 Configuration Tools > Pins
P16 RGMILA_RXD0 Jo——7F paasen " GWACT RXDT pig | PE_10/GMACO_RXDO'PFE_MAC1_RXDO0 Jeam | S i
P16 RGMILA RXDT & GWMACT_HXDZ Nig | PE_11/GMACO_RXD1/PFE_MAC1_RXD1 Compar it > Open it
P16  RGMI_A_RXD2 TACT XS UZ1 | PE_12/GMACO_RXD2'PFE_MAC1_RXD2 S . B openivT
P16 RGMI_A_RXD3 = PE_13/GMACO_RXD3PFE_MAC1_RXD3 3 ke S Open QuadsP!
; @ Open DDR
Properties Alt+Enter Import Configuration (*.mex)
Routed Pins v
# 3 Label Identifier Power group Direction Output Buffer Open Drain  Input Buffer Slew Rate Control Pullup Enable
P207G 0 ticka PED2 n/a VDD_I0_GMACO (0V) Output Enabled Disabled ~ Disabled  SIUL2 0: FAST pad- 166MHz{1.8V), 150MHz(3.3V) - GPIO pad: 166MHz(1.8V), 50Mhz(3.3V) / SIUL2_1: 150MHz or lower Disabled
R21GMAC O redki PEOS n/a VDD_I0_GMACO (0V) Input Disabled Disabled ~ Enabled  SIUL2_0: FAST pad: 166MHz(1.8V), 150MHz(3.3V) - GPIO pad: 166MHz(1.8V), 50Mhz(3.3V) / SIUL2_1: 150MHz or lower Disabled
p pa pa

@ .
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HANDS ON ETH : CLOCK CONFIGURATION

Open the Peripheral Clock View, and double-click the GMACO module. The Clocks Diagram shows the clock
tree of GMAC module

'\\ i
# Overview © Peripheral Clock View 2 [9) Code Preview [T Registers i= Details FIRC_CLE ——M ]
Clock Name Enable Source Divider ~Frequency o E_;;EW ;IIEG "‘cg;Rz}[E—CI];,KI E
FLEXCAN3_CLK v FIRC_CLK /1 48 MHz T |
FRAYD_CLK v FIRC_CLK /2 24 MHz GMAC_REF DIV _ |
FTIMERO_CLK v FIRC_CLK /1 48 MHz E
FTIMER1 CLK 7 FIRC_CLK /1 48 MHz enac ext ts ref G'*‘%TS;E?LIKHZ :
GMACO_RX_CLK v GMAC_EXT RX_REF /1 25 MHz PRRIFHPLL FMACO_TS_CLK
GMACO_TS_CLK M FIRC_CLK /1 48 MHz Fld —> 48 MHz |
GMACD_TX_CLK v PERIPH PHIS /5 25 MHz FIRCCLE ey E
TCO.CIR v XEAR. DI LK 77 A= ‘ !
IIC1_CLK v XBAR_DIV3_CLK /1 8 MHz SERDES_0_XPCS_0_TX | S
NC2_CLK v XBAR_DIV3_CLK /1 8 MHz gnac_ext_ref N o5 NHz -
NC3_CLK L XBAR_DIV3_CLK i 8 MHz =Ty GNACO_TY_CLE |
IC4_CLK | XBAR_DIV3_CLK /1 8 MHz grac_ext_txref o0 Lg7 5 | D]t 25 Mz :
LBISTO_CLK v FIRCCLK /1 48MHz PERI PHPLL-PHI;./ :
LBIST1_CLK i FIRC_CLK /1 48 MHz FIRC_CLK N !
LBIST2_CLK | FIRC_CLK 1 48 MHz e |
LBIST3_CLK v FIRC_CLK /1 48 MHz N !
LBIST4_CLK v FIRC_CLK /1 48 MHz PERIPHFLL_PHI3 ) :
LBISTS_CLK v FIRC_CLK /1 48 MHz FXOSC_CLK | !
LBIST6_CLK v FIRC_CLK i1 48 MHz FIRC _CLE / :
LBIST7_CLK ¥ FIRCCLK /1 48MHz 4 ;
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HANDS ON ETH: ETH CONFIGURATION

Open the peripheral configuration:
- Right-click the Project
- Select S32 Configuration Tools

- Select Open Peripherals

4 Project Explorer &
> wl Includes
> @ Project_Settings
> sre
> @ include
B description.oat
B Gmac_Example_DS (]

b F EN=

(ot

[+]
*

=]

New
Go Into

Open in New Window
Show In

Show in Local Terminal
Copy

Delete

Paste

Rename..

Source

Move...

Import...

Export...

Build Project

Clean Project

Refresh

Close Project

Close Unrelated Project

Build Targets
Index
Build Configurations
Build path
Build Configurations Explorer
SDKs
Migrate...
Show in Remote Systems view
Run As
Debug As
i m | Hi:

Team
Compare With
Configure
Source
Validate

Properties

Alt+Shift+W >
>

Ctri+C
Delete
Ctri+V
F2

>

F5

D

v ov v v

Alt+Enter

Be®Y § =0

# Open Pins

n Oin Clocks
Open DCD

= OpenIVT

= Open QuadSPI

¥ Open DDR
Import Configuration (*.mex)
Manage SDK Components

—)

Select Components to find out GMAC Driver
and double-click

|‘Cnmpnnents HI * Peripherals = 8
JC- 50

!

s Gmac 22 i
GMAC Configuration pers) &
Name Gmac Custom name [
Mode GMAC Mode

Preset Custom. +

Name G |EthConfigSet|

Preset | Custom... ¥

Name [EthConfigSet

T HEE

 EthCtriConfig

0 Name [EthCtricenfig 0
EthCtriEnableMii (]
EthCtriEnableMmd a

EthCtriEnableRdnterupt [
EthCtriEnableTxinterupt [
EthCtrlldx o ]
ETH_MAC_LAYER_TYPE_XGMII v ‘

EthCtriMacLayerType

v EthCtriMacLayerSubType
REDUCED v =
+

~ EthCtriMaclayerSpeed

ETH_MAC_LAYER_SPEED_100M v][=
et

~ EthCtriPhyAddress

[6655:44332211 B 23




HANDS ON ETH: UPDATE CODE

Generate code method:

1. Open the view of any configuration tool, like
Pins, then click Update Code (ensure desired
project is selected)

Al = - - S oamrr -~ 2
Navigate NEaArch Froect

- | a4 . Gmac_lp_Internalloopback_S32G3 \@

Yernohera

1 -
Uun

A B UpdateCode| v+ 1 B

2.The Update Files window pops up. It shows
the detailed update information. Click OK button.

3.The configuration .c and .h files will be
generated in "generate” folder.

[] Always show details before Update Code

ﬁ Update Files O - ‘
Generated file I Status "
- E Pins 9 emor

- @ board',
Esiul2_Port_lp_Cfg.c B create
EsSiul2_Port_lp_Cfg.h Bl create
- M Clocks B error
=& generate\,
- HAinclude),
M Clock_Ip_BOARD_InitPeripherals_PBcfg.h B create
[ Clock_Ip_Cfgh B create
Clock_lp_Cfg_Definesh Bl create
= [ generate\,
=[Esrc',
[ ol P T oA S T S S S Uy T, Y S, 1= —— b
Options
Cancel

v 15 Gmac_lp_InternalLoopback_S32G399A_M7: Debug_RAM
») Includes
@ Project_Settings
& RTD

3 ) 9 board
= generate

v (& generate/include
(8 Clock_Ip_BOARD_InitPeripherals_PBcfg.h
i Clock_Ip_Cfg_Defines.h
{8 Clock_Ip_Cfg.h
0 Gmac_lp_Cfg.h
[ Gmac_lp_Device_Registers.h
|8 Gmac_lp_Features.n
{n Gmac_lp_Sa_BOARD_InitPeripherals_PBcfg.h
{n modules.h
in Oslf_ArchCfg.h
in Oslf_Cfg.h
in Siul2_Port_Ip_Defines.h
v (2 generate/src
lg] Clock_Ip_BOARD_InitPeripherals_PBcfg.c
lg Clock_Ip_Cfg.c
lg Gmac_lp_Cfg.c
lg Gmac_lp_Sa_BOARD_InitPeripherals_PBcfg.c
\€ Oslf Cfg.c
src

24 VAN



HANDS ON ETH: APPLICATION CODE 1

Dissecting the main.c

int mainivoid)

{
Gmac_Ip_TxOptionsType txOptions = {TRUE, GMAC_CRC_AND_PAD_INSERTION, GMAC_CHECKSUM_INSERTION_DISABLE};
Gmac_Ip_BufferType txBuffer = {@};
Gmac_Ip_BufferType rxBuffer = {8};
Gmac_Ip_TxInfoType txInfo;
Gmac_Ip_RxInfoType rxInfo;
Gmac_Ip_StatusType status;
uint8 macAddr[8U] = {8U};
uint8 i;
uint8 j = eu;
boolean result = TRUE;

OsIf_Init(NULL_PTR);

Initialize pins to provide the external clock for GMAC

Clock_Ip_Init(&Mcu_aClockConfigPB[8]);
Gmac_Ip_Init(INST_GMAC_@, &Gmac_@_ConfigPB_BOARD_INITPERIPHERALS); Enable GMAC controller, initialize Tx and Rx buffer via the function

f* Setup the frame with the Mac address and size */ GmaC_Ip_Inlt
Gmac_Ip_GetMacAddr(INST_GMAC_@, macAddr);

/* Request a buffer of at least 64 bytes */
txBuffer.length = 64U;
if ((GMAC_STATUS_SUCCESS != Gmac_Ip_GetTxBuff(INST_GMAC_@, @U, &txBuffer, NULL_PTR)) || (txBuffer.length < 64U))
{
result = FALSE;
}
for (1 = BU; i < 12U; i++)
{ . .
LUETED ) (EASUFTar- AtaRU] + 4)) = Sacadar[e & 31: Apply for Txbuffer via the function Gmac_Ip_GetTxBuff
C s and initialize transmission buffer
} »
else
{
j = eu;
b
}

25



HANDS ON ETH: APPLICATION CODE 2

Dissecting the main.c

/* Payload = Frame - (DstAddr + SrcAddr + EtherType/Length + FCS) */
*({uint32 *)(txBuffer.data + 13U)) = 64U - (BU + 6U + 2U + 4U);

/* Send the ETH frame */

txBuffer.length = 64U - 4U; /® Don't count FCS5, because it is automatically inserted by the controller in this example */
if (GMAC_STATUS_SUCCESS = Gmac_Ip_SendFrame(INST_GMAC_®, @U, &txBuffer, &txOptions)) Transmit frame via Gmac Ip SendFrame
{ M
result = FALSE;
}
/* Wait for the frame to be transmitted */
do {

status = Gmac_Ip_GetTransmitStatus(INST_GMAC_®, &U, &txBuffer, &txInfo);
} while (status == GMAC_STATUS_BUSY);

/* Check the frame status */
if ((GMAC_STATUS_SUCCESS != status) || (8U != txInfo.errMask))

result = FALSE;
}

Lo (77 Tor he frame e be recsived Verify frame is transmitted or received

status = Gmac_Ip_ReadFrame(INST_GMAC_@, U, &rxBuffer, &rxInfo);
} while (status == GMAC_STATUS_RX_QUEUE_EMPTY);

/* Check the frame status */
if ((GMAC_STATUS_SUCCESS != status) || (8U != rxInfo.errMask))

{
}

Gmac_Ip_ProvideRxBuff(INST_GMAC_B, BU, &rxBuffer);

result = FALSE;

Gmac_Ip DisableController(INST_GMAC_B);
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HANDS ON ETH: BUILD AND DEBUG 1

Build target Project:
Right-click the Project
Build Project

The console print build information

Gmac_Ip_InternalLoopback S32G399A M7.elf is
created

viS6 ni e
@ Project S¢ Go Into
& RTD Open in New Window
@ board Show In Alt+Shift+W »
&2 generate Show in Local Terminal »
&2 generate) [ Copy Ctrl+C
2 generate/ 3¢ Delete Delete
v @ sic [ Paste Ctri+V
[¢ mainc = Rename.. F2
Source »
tg Move...
";u Import...
3 Export.
Build Project
CTEan Project
Refresh F5
Close Praoject
Close Unrelated Project
Build Targets >

w 15 Gmac_lp_InternalLoopback_$32G399A_M7: Debug RAM

- |

i3 Gmac_lp_IntemalLoopback_S32G399A_M7.elf - [arm/le]
imiF InCluges
2 Project_Settings
& RTD
&5 board
& generate
& generate/include
&2 generate/src
v B src
[€ maine
& Debug_RAM
A nciuce
f{ descrniption.txt

B Gmac_Example_DS_003.mex

T 2 Console &2 .
CDT Build Console [Gmac_lp_InternalLoopback_S32G399A_M7]
Building target: Gmac_Ip_Internalloopback_S32G399A_M7.elf
Invoking: Standard $32DS C Linker
arm-none-eabi-gcc -o "Gmac_Ip_InternallLoopback_S32G399A M7.elf" "@Gmac_Ip_Internal
c:/nxp/s32ds.3.4/s32ds/build_tools/gcc_v9.2/gcc-9.2-arm32-eabi/bin/../1ib/gcc/arm-
Finished building target: Gmac_Ip_Internalloopback_S32G399A M7.elf

Invoking: Standard $32DS Print Size
arm-none-eabi-size --format=berkeley Gmac_Ip_InternallLoopback_S32G399A M7.elf
text data bss dec hex filename
291884 @ 12289 304173 4a42d Gmac_Ip_InternallLoopback_S$32G399A_M7.elf
Finished building: Gmac_Ip_Internalloopback_S32G399A M7.siz

10:41:15 Build Finished. @ errors, @ warnings. (took 17s5.527ms)
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HANDS ON ETH: BUILD AND DEBUG 2

Go to debug configuration:
- Right-click the Project
- Select the Debug As

- Click on Debug Configurations

{ o Gmac Ip Internal
" Binaries

Includes

& Project_Settings

New >
Go Into

Open in New Window

Show In Alt+Shift+W >
Show in Local Terminal >
Copy Ctri+C
& generate/includi ® Delete Delete
& generate/src T Paste Ctri+V
v @ src ™ Rename.. F2
lg main.c Source >
& Debug_RAM .
- s Import...
£ s Export.
%
Build Project
Clean Project
Refresh F5

Close Project
Close Unrelated Project
Build Targets >
Index >
Build Configurations >
Build path >
Build Configurations Explorer
SDKs
Migrate...
Show in Remote Systems view
©Q RunAs
| % Debug As

Restore from Local History...

1 Local C/C++ Application
2 532DS C/C++ Application

$32 Configuration Tools

Debug Configurations...

Team

Compare With >

Configure >

Source >
vl Validate

Properties Alt+Enter

Debug configuration setting:

Click on target project

FPo@EX|BYT ~
type filter text
[€] C/C++ Application
[€] C/C++ Remote Application
& Eclipse Application
[€] GDB Hardware Debugging
B3 GDB PEMicro Interface Debugging
[€] GDB SEGGER J-Link Debugging
& Launch Group
¥ Launch Group (Deprecated)
¥ Launch Group for $32 Debugger
~ §32 Debugger
I Gmac,lp,lntemalloophackji26399A,M7,Denug,RAMji2De|:|ug|
$32 Debugger Flash Programmer
VLAB Simulator Debugging

Connect the S32 Debug probe with PC and RDB3

Select the target device and core as S32G399A M7 0
Select target S32 Debug Probe

Name: | Gmac_lp_InternalLoopback_S32G399A_MT_Debug_RAM_S32Debug

Main | 3% Debugger . # Startup| %~ Source| ] Common | ! SVD Support| #8 OS Awareness| & Trace and Profile

Hardware
| Device: 53263994 Core: M7.0]

Initialization script: | ${532D5_INITIALZATION_SCRIPTS_DIR}/s32g3xx¢/s32g3xx_generic_bareboard.py
Initial core

Debug Probe Connection

Interface: 532 Debug Probe - USB

USB device: 00:04:97:06:6d: 1e - S32 Debug Probe

<

Hostname or IP:

Target Communication Speed

JTAG Speed (KHz): | 16000 Timeout:[30  |s
[[] Delay after reset: 0 ms
GDB Server

Launch server
Server port number® | 45000

28
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HANDS ON ETH: DEBUG AND RUN

Power on the RDB3, click on "Apply", then click on "Debug". The view will switch to the Debug Perspective,
and you can use the controls to control the program flow.

-

1 Debug 2
- B i 3
- v c mal 32G399A M7, g
[ e Ema\_m.hxe mailoopback_S32G399A_M7_Debug
v i Gmac_lp_InternalLloopback_S32G399A_M7.elf [
Debug Probe Connection v o Thread #1 1 [core: 0] (Suspended : Breakpoi
= main() at main.c:66 0x340001e0
Interface: 532 Debug Prabe - USB - 8 C/NXP/S32D5.3.4/532D5/tools/gdb-arm/arm3
- . »i S32 Debugger
USB device: 00:04:91:06:6d:1e - S32 Debug Probe ~ | Refresh | Test connection e
»i Semihosting
Hostname or IP:
Target Communication Speed. ) ) B 64 int main(void)
JTAG Speed (KHz): [16000 Timeout: |30 5 § 65 . -
| b |  Gmac_Ip TxOptionsType TxOptions = {TRUE, GMAC_CRC_AND_PAD_INSERTION, GMAC_CHECKSUM_INSERTION_DISABLE};
[[] Delay after reset: 0 ms 5 Gmac_Ip_BufferType TxBuffer = {0};
3 Gmac_Ip BufferType RxBuffer = {0};
GDB Server 59 Gmac_Ip_TxInfoType TxInfo;
70 Gmac_Ip RxInfoType RxInfo;
Launch server 1 Gmac_Ip_StatusType Status;
Server port number®| 45000 | “ uint8 MacAddr(6U] = {eU};
° 7 uint8 i;
[JEnable log A uint8 j = ou;
boolean Result = TRUE;
GDB Client v
OsIf_Init(NULL_PTR);
o Siul2_Port_Ip_Init(NUM_OF_CONFIGURED_PINS@, g_pin_mux_InitConfigArr@);
Clock_Ip_Init(&Mcu_aClockConfigPB[@]);
Coze 8 Gmac_Ip_Init(INST_GMAC_@, &Gmac_@_ConfigPB_BOARD_INITPERIPHERALS);

* Setup tt frame with the Mac address and size *

Gmac_Ip_GetMacAddr(INST_GMAC_@, MacAddr);
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HANDS ON ETH: TEST RESULT 1

In this project, the Ethernet module works in internal loopback mode. Add a breakpoint to the last line of the main
function, then click on the Resume option. The received ETH frame can be watched from rxBuffer.

workspace532DS.3.4 - Gmac_lp_InternalLloopback_S32G399A_M7/src/main.c - 532 Design Studio for $32 Platform — X

File Edit Source Refactor MNavigat h Project ConfigTocls Run Window Help

iH | BT = i LI | Sid-ids~ O~ QueiB®F~iJifvrilroarD~|t Q g BEEM eSS
15 Debug 2 5 Project Explorer = nain.c main.c Siul2_Port_lp.c Siul2_Port_ inker_ram_ startup_cm7.s [¢ mainc 2 ™18 = B  ==Var. ¥ %Bre.. & Ex. =iMo.. #iiPer. #¥Arn. UEm. B Per. T O
| | g 120 status = Gmac_lp_LeT|ransmit>tatus(Lli>d|_LMAL_W, WU, &IxButter, &ixlnto); ~ IR
© oL - . y . 18 =
v = Gmac_lp_Internalloopback S326399A 3 while (Status == GMAC_STATUS BUSY); Name Type Value
~ i Gmac_lp_Internalloopback_532G3¢ 23 /* Check the frame status */ = TxOptions Gmac_lp_TxOptionsType {.}
~ o Thread #1 1 [core: 0] (Suspender | 124 if ((GMAC_STATUS_SUCCESS != Status) || (@U != TxInfo.ErrMask)) = TxBuffer Gmac_lp_BufferType .}
= main() at main.c:146 0x34000 125 { ~ (= RxBuffer Gmac_lp_BufferType {.}
# C/NXP/532D5.3.4/532D5/tools/gdl | 120 Result = FALSE; *+ Data uintg * 0x34501d00 <GMAC_0_RxRing_0_Dat
5 532 Debugger fé ¥ - Length uint16 64
» Semihostin . . . . . a
. o 29 /* Wait for the frame to be received */ & Tuinfo Gmac_Ip_TxInfaType {.}
130 do { = Rxlnfo Gmac_lp_RxInfoType .} o
131 Status = Gmac_Ip_ReadFrame(INST_GMAC_@, OU, &RxBuffer, &RxInfo); 9= Status Gmac_lp_StatusType <optimized out>
132 } while (Status == GMAC STATUS_RX_QUEUE_EMPTY); = MacAddr uints [6] 0x344019¢
133 ) ) 09= | uint8 <optimized out=
134 /* Check the frame status */ o uint8 <optimized out>
135 if ((GMAC_STATUS_SUCCESS != Status) || (@U != RxInfo.ErrMask)) : o
i 09= Result boolean <optimized out>
120
137 Result = FALSE;
138 ¥ < >
139
140 Gmac_Ip_ProvideRxBuff(INST_GMAC_@, @U, &RxBuffer); : =
141 %% Qutline &2 Bl e ¥ § =0
142 Gmac_Ip_DisableController(INST_GMAC_@); 4 Gmac_lph
—ji EE— o Siul2_Port_Iph
1 xit Example(Result); 2 Oslfh
return 9; H Clock_Ip.h
< = check example.h
148 #ifdef _ cplusplus @ main(void) : int
#a Dashboard £ 2§ =0 149 }
1560 #endif
~ Project Creation ~ Setting 151 v
7 532D5S Application Project &8 Projec < >
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HANDS ON ETH: TEST RESULT 2

The received frame can be watched in rxBuffer.

=Variables & %s Breakpoints Expressions B\ Modules Peripheral Reqgisters Arm System Registers EmbSys Registers Peripherals
k

MName Type Value

> (= TxOptions Gmac_lp_TxOptionsType {-}

» (™ TxBuffer Gmac_lp_BufferType {.}

~ = RxBuffer Gmac_lp_BufferType

> w Data uintsd * <GMAC_0_RxRing_0_DataBuffer> “fUD3\"\021fuD3\"\021"
= Length uint16

> (= Tuinfo Gmac_lp_TuinfaType
B Console il Registers [£] Problems 3 Executables [3) Debug Shell [ Memory Spaces ! Watch registers G Debicaaccenss|d [ Memory &2
Monitors = 0534501000 : 0x34501D00 <Hex> i1 < New Renderings..

@ 0x34501d00 &= Address 4 -7 8 -B C-F

CUELTEEEN 22116655 44332211 |002£0000

34581018 0000000  GO000000  AEOBDBE
34501D20 ©ooed00e POe6BaRa Bopapa0e pavasaaa
34561030 ©0000000 00000000  OODDBOOB  65EALS43
34561046 GeR0B8 PABGBABA BopaBase PABABRDA
34501D50 00EAOGE0  NOBOREAO  PEERABBR  PEAABRRe
34501Dc8 ©eee08e  0ODDBDEE  BO000EEE  BEOBDBE8
345010786 o©eoetooe pOe6BaRa B0eapa0e paBasaaa
34501080 0000000 00000000  O0ODDBOO0  POOOOO00




Hands on CAN Example
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HANDS ON CAN - OBJECTIVE

—How to import the CAN example into S32DS

—How to configure the clock of CAN via S32DS

—How to configure the port of CAN via S32DS

—How to modify the CAN loopback

—How to debug the CAN example with S32 debug probe

33
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HANDS ON CAN : IMPORT CAN EXAMPLE PROJECT

Open S32 Design Studio, go to "File -> New -> S32DS Project From Example". Select
"FlexCAN_Ip_Example S32G399A M7" example, then click on “Finish”. The project is copied into current

workspace.

workspaceS32DS.3.4 - 532 Design Studio for 532 Platform

File Edit Source Refactor Navigate Search Project ConfigTools Run Window Help

New
Open File...

. Open Projects from File System...
Recent Files >

Alt+Shift+N >

Rename... F2
Refresh FS
Convert Line Delimiters To >

By default,

1 (=) (81

51

$32DS Project from Example
S320S Library Project

$32DS Application Project
Makefile Project with Existing Code
C/C++ Project

Project..

Convert to a C/C++ Project (Adds C/C++ Nature)
Source Folder

Folder

Source File

Header File

File from Template

Class

Example...
Other...

Create 532DS Project from Example

Ctri+Alt+E Project name: .FIExCANJpﬁExamuI275326399A7M?
Ctri+Alt+L

Ctri+Alt+A

can

Examples:
~ [ 532 RTD AUTOSAR 4.4 3.0.2 HF01 D2204 Exam ~
~ & Can Examples
& Can_example_S32G274A_M7
& Can_example_532G399A_M7
& Can_example_S32R45_M7
FlexCAN Ip Example 532G274A M7
I = FlexCAN_Ip_Example_S32G399A_M7 I
= FlexCAN_lp_Example_S32R45_M/
~ & 532 RTD AUTOSAR 4.4 D2105 Example Project
~ & Can Examples
= Can_example_S32G274A_M7
= Can_example_S32R45_M7

Ctri+N < L

S32G-VNP-RDB3

>
CAN

(_

FlexCANO

Description

1. Example Description
This is an FlexCAN IP driver component LoopBac
example.

1.1 The application software functionality
Using Clock_lp_Init it initializes the clock sourc
the clock tree and to configures the clock gating of th
peripherals. The clock configuration that is used will
enable and use the PLL as source clock.

With IntCtrl_Ip_Init it initializes the interrupt
controller and it applies the interrupt configuration
according to the Platform configuration. The interrup
handlers are mapped using calls of
IntCtrl_lp_InstaliHandler. The application will register
CANO_ORED_0_7_MB_IRQHandler ISR handler and wi ,

Cancel

= FlexCAN_Ip_Example_532G399A_MT7: Debug_RAM
ni Includes
A & Project_Settings
& sre

"FlexCAN_Ip_Example S32G399A MT7" project only shows the LoopBack function of FlexCAN.

TJIA1043
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HANDS ON CAN: MODIFY THE EXAMPLE

The "FlexCAN _Ip_Example S32G399A MT7" project only supports loopback mode. This guide will demonstrate
how to modify the default configuration to transmit CAN frame from FlexCAN_0 to FlexCAN_1

FlexCAN_O connect to FlexCAN_1 via physical wiring

Automotive Bus Port

Jg
P4 El I:x:u:v == AN 2 — ] 1 N E| EYREY A BR P4

P27 FLEX_CAND_H <<y e 05 <Y FLEX CANO L P27

P27 FLEX CANI HCCOH o1 [ 11— &%y FLEX CAN1 L P27

T8 LLC E_CAND H <> 0 o L5 <or LLCE. CANO L P28

P28 LLCE_CAN1_H < w4 O {>> LLCE CAN1_L P28

P28 LLCE _CANZ H << 4 O3 > LLCE CANZ L P28

P28 LLCE CAN3 H £ e O35 <> LLCE CAN3 L P28

P30  LLCE GAN4 H<<> a1 057 ¢ LLCEGAN4 L P30

pog s H <GS 205 oo %0 LCE CANEL e

24 b £a

p2g H &¢y 2 00Ot ¢S5 LLCE CAN7 L P28 i

P30 LLCE CANS H<<> oo O <>» LLCE CANB L P30 o $32G399A
P30 LLCE CANY_ H<<> s 015 £y LLCE CAN9 L P30 )
P20 LLCE_CAN10_H < 3 %9 <% LLCE CAN1O L P29
P29 LLCE CAN11_H << 5 O35 <35 LLCE_ .n"“l L P2
Efc LLCE_CAN1Z_H <Y 5 O3 (> LLCEGAN1ZL P30 J

30 LLCE_CAN13_H < w0 O <> LLCE CAN13 L P30 | i
P29 LLCE CAN14 H {{» a8 1 [T a7 <»» LLCE_CAN14_L P29 3 U
P20 LLCE CAN15 H £ o= O—139 <»> LLCE CAN15_L P23 — ;
{1 [

.|”_
.|||,

]
=
=)
(=]
[=}
=
Ty
S
w
=
()

)

.L.
—_l'_:'.-
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HANDS ON CAN: PORT CONFIGURATION 1

Go to Pin configuration view:
Right-click the Project
Select S32 Configuration Tools

Select Open Pins

Enable Pins

New >

i) Includes Go Into

@ Project_Settil

@ sre Open in New Window

Show In Alt+Shift+W >
Show in Local Terminal »

Copy Ctri+C
Delete Delete
Paste Ctrl+V
Rename... F2
Source »
Move...

Import...
i Export.
Build Project
Clean Project
Refresh F5
Close Project
Close Unrelated Project
Build Targets >
Index »
Build Configurations »
Build path >
Build Configurations Explorer
SDKs
Migrate..
Show in Remote Systems view
O RunAs >
4 Debug As >

532 Configuration Tools > Open Pins

Team >

Compare With >

Configure b

Source >
¥ Validate

Open Clocks

Open Peripherals

Open DCD

Open IVT

Open QuadSPI

Open DDR

Import Configuration (*.mex)
Manage SDK Components

% = S|=

S0l

Properties Alt+Enter

3 Config Tools Overview

9 Pins tool is disabled. Either enable it or select different tool.

v Configuration - General Info
Name: FlexCAN_example_CT.mex
Path: C:\Users\NXF65386\wo.._Example_S32G399A_M7

v Configuration - HW Info
Processor: S32G399A
Part number: S32G399A_525bga
Core: Cortex-M7 (Core #0)

SDK Version: PlatformSDK_S32XX_2022_03

v Pins v Clocks v Peripherals v DCD
Configu Configu Configu Device
Lt res pin res the res the ol Configu
| routing, initializa initializa ®’§ ration
includin tion of tion of Datais
g the the SDK the
function core, periphe configur
al system, ral ation
electrica bus, drivers. informat
| pin and [ o] ion
properti periphe containe
es, ral v Generated code d in the
voltage/ clocks. oco
power @ Update code enabl e
rails, ¥ genera.. Cfgh that the
and ~ Generated code BootRO
run-time ..fines.h M
p pdate code enabl i JEneHtfes Starpre
configur genera..Bcfgh ¥ genera.Bcfgh tsto
tion ~ configur
[ OB | genera.._Cfgh @ genera.. Cfgh e
> various
v Functional groups generat..finesh 4 generat.finesh periphe
. ) rals on
2 genera..Bcfg.c ¥ generat..dulesh the
¥ genera.. Cfg.c < genera_hCigh i
@ generat.f Cfah

~ Functional groups
™ BOARD..ckRUN

@ generat..finesh

¥ genera..Bcfg.c

@ genera.. Cfg.c

¥ generat..f Cfg.c
v Functional groups

™ BOARD_-herals

v Project
Project name: FlexCAN _Ip_Example S32G399A_M7
Toolchain: NXP GCC 9.2 for Arm 32-bit Bare-Metal
Processor: S32G399A
Part number. S32G399A_525bga
Core: Cortex-M7 (Core #0)

¥ QuadSPl v DDR
Configu QuadsPi The
res the tool DDR
Image allows Tool
Vector the provide
Table configur S user
o, ation of friendly
which is the configur
the first paramet ation of
data ers and initializa
structur the tion for
e that require DDR
the Boot d controll
ROM details ersand
code that will allows
reads be you to
from progra validate
the mmed the
boot in flash configur
device. memory ation
An VT . The using
contains result various
the configur validatio
require ation n
d data will be scenario
compon exporte s.
ents like ina [ o)
an .bin file
image that will
entry be
point, a importe
Device din the
Configu QuadsPi
ration paramet
Data ers field
(DCo) of the
pointer, VT tool.
and
other
pointers.
used by
the Boot
ROM
code
during
the
boot
process.
o o
Close and Update Code Close

36



HANDS ON CAN: PORT CONFIGURATION 2

Add the Pins as the schematic of FlexCANO and FlexCAN1

S;JLE)(:_&I\
:EUF
“;;?:hs‘;f 1 " 1 | T
i = = Ty e S B
U:— e ; 24 lene Pal  FLEX CANI STB Jp— B3 oo 00 "y 578 T .o rsip. . one | DY | pesomzer
G % | g ﬁgﬁ? FE = [ "
Routed Pins for BOARD... | 4 | @ & v
# Peripheral Signal  Routeto Label Identifier Power group Direction Qutput Buffer Open Drain Input Buffer
B cano nd PB_02 n/a VDD_IO_B(0Y)  Input  Disabled  Disabled  Enabled
E7 CAN 0 txd PB 01 n/a VDD 10 B (0V) QOutput  Enabled Disabled Disabled
E8 CAN _1 rxd PB 04 n/a VDD 10 B (0V) Input Disabled Disabled Enabled
C6 CAN _1 txd PB 03 n/a VDD 10 B (0V) QOutput  Enabled Disabled Disabled
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HANDS ON CAN: PORT CONFIGURATION 3

2.

> w Includes
> @ Project_Se
~ B sre
> [€ mainc
> @ include
B descriptior B
B FlexCAN & 9¢
I
™

b E

(]
*

New
Go Into

Open in New Window
Show In

Show in Local Terminal
Copy

Delete

Paste

Rename...

Source

Move..

Import...

Export..

Build Project

Clean Project

Refresh

Close Project

Close Unrelated Project

Build Targets
Index
Build Configurations

Build path

Build Configurations Explorer

SDKs
Migrate...

Show in Remote Systems view

Run As
Debug As

Alt+Shift+W

Ctrl+C
Delete
Ctri+V

F2

FS

»

»

>

wow v v

>
“

Restore from Local History..
T r—

%]

Team
Compare With
Configure
Source
Validate

Properties

Alt+Enter

> NN Open Clocks
>
» & OpenDCD
5 = OpeniT
= Open QuadSPI
® Open DDR
Import Configuration (*.mex)

Manage SDK Components

Add the Port configuration:
- Right-click the Project,
- Select S32 Configuration Tools
- Select Open Peripherals
- Click on the plus button
- Click on the Siul2_Port component
- Click on OK
- The Siul2_Port driver will be added

& Components I | 4* Peripherals

|t',rpe filter text

W Select configuration component

Select which components should be offered |Latest component

B

[siul2)

x]

Configuration component Component description

Category R
Drivers pla
Drrivers pla

& Siul2_Dio Siul2_Dio Configuration
& Siul2_lou SIUL2 Driver
| * Siul2_Port Siul2_Port Configuration Drivers Ipl

& Components =2 <’ Peripherals

|type filter text

PUBLIC 38




HANDS ON CAN: CLOCK CONFIGURATION 1

Switch to clocks configuration view: [T ] tew >

Go Into
& Project_Settings : :
Open in New Window

- R|ght'CI|Ck the PrOjeCt, s Show In Alt+Shift+ W >

v @3 src

J mai i i >
[§ main.c Show in Local Terminal

- Select S32 Configuration Tools s

R @

Copy Ctri+C
Delete Delete
Paste Ctri+V
Rename... F2
Source >

Move...

=

- Select Open Clocks

£

s Import..

i Export.
Build Project
Clean Project
Refresh F5
Close Project
Close Unrelated Project
Build Targets >
Index >
Build Configurations >
Build path >
Build Configurations Explorer
SDKs
Migrate...
Show in Remote Systems view

© RunAs >
4 Debug As >

Restore from Local History...
I: m@rm 1 @ Open Pins

Team > l_'"' Open Clocks
Compare With > | ¥ Open Peripharale —
Configure 5 & OpenDCD _()prn(rocks
Source , = OpenINT
¥ Validate S Open QuadSPI
@ Open DDR
Properties Alt+Enter

Import Configuration (*.mex)
Manage SDK Components




HANDS ON CAN: CLOCK CONFIGURATION 2

Open the Peripheral Clock View, double-click the FLEXCANO CLK. The Clocks Diagram will show the
clock tree and the key node can be re-set. The default clock configuration of FlexCAN is 48 MHZ. Switch
the clock which source from FXOSC(40 MH2Z).

F)}a CCC K ﬂg
# Overview () Peripheral Clock View 21 [c] Code Preview [ Registers I= Details 2
FIRC 800 MHz | R &
Clock Name Enmable Source Divider Frequency 32 qu CORE_PLL DFsl'B
DMAMUX0_CLK % XBAR_DIV3_CLK 11 13333.... .
DMAMUX1_CLK % XBAR_DIV3_CLK /1 12.3338... o= o e
DMAMUX2_CLK % XBAR_DIV3_CLK /1 133.33... g VTERNAL CLOCKS 1 coRm_pLL PHI
DMAMUX3_CLK % XBAR_DIV3_CLK 11 133.33.... D R e 400 iz
FIRC
DMA_CRCO_CLK %} XBAR_CLK /i 400 MHz T LOR_PLL P
DMA_CRC1_CLK % XBAR_CLK /1 400 MHz S o -
EIMO_CLK % A53_CORE_DIV10C.. /1 4.8 MHz | ETERaeZ ST} FIRC e
EIM1_CLK ™ XBAR_DIV6_CLK /1 6666.. | T ACCEL PLL P - SRR
i . . | 00 - 43 MH Gl—L‘CCRKF_EIV
EIM2_CLK %l XBAR_DIV6_CLK 11 66.66.. . PERIPE_PLL Pm R R PR
EIM3_CLK ™M XBAR_DIV6_CLK 1 66.66... .. TIRC o) /1 /1 | oowm SERES
EIM_CLK % XBAR_DIV6_CLK I 66.66... .. : o 45 iz 48 Wiz 48 Wiz : SRS
ENET_LOOPBACK CLK [ FIRC_CLK /1 48 MHz : 1 rme FIRC o ; N, ShRoE
ERMO_CLK ™ XBAR_DIV6_CLK i1 66.66... .. T o ez Emac_ext T4 prenacO_ext péptenscl_ext|refenact exfAer oo wiz  ——IS CORE BLE
FLEXCANO_CLK % FXOSC_CLK /" 40 MHz
FLEXCANT_CLK %] FXOSC_CLK i 40 MHz
FLEXCANZ2_CLK %] FXOSC_CLK /1 40 MHz V
FLEXCAN3_CLK % FXOSC_CLK /1 40 MHz FLE D{iﬂlcﬁ
FRAYD_CLK 5] FIRC_CLK ]2 24 MHz S LEY CANO CLI'%
FTIMERO_CLK % FIRC_CLK 11 48 MHz b -
- FERIFPHFLL_F 40 MHz
FTIMER1_CLK _ FIRC_CLK /1 48 MHz n
; LEXCAN1_CLK
GMACD_RX_CLK %] FIRC_CLK /1 48 MHz FROSC_CLK A 40 MHz
GMACO_TS_CLK M FIRC_CLK /1 48 MHz FIRC_CLK LEXCANZ_CLK
GMACO_TX_CLK i FIRC_CLK /1 48 MHz 40 WHz
E)EAH 3_CLK
40 MHz




HANDS ON CAN: CAN CONFIGURATION 1

Mode setting for FlexCANO:
Right-click the Project,
Select S32 Configuration Tools

& Components & -0

type filter text + MR T

MCAL L+

Select Open Peripherals o

Double-click FlexCAN component OfecAN |  OmCrp | Oositi Siul2_Port
Set mode for FlexCANO

CAN Commmmems e — e —ee
New - .
Soaws | IP FlexCAN DriveNgers o
9 Project_Se
~ & src Open in New Window
(€ main.c Show In Alt+Shift+W >
Show in Local Terminal » Mode General Mode v
- Copy Ctrl+C
B FlexCAN e 3¢ Delete Delete Preset Custom..

T Paste Ctri+V
™ Rename.. P2 Name | Config Time Support] FlexCAN configurations JFlexCAN General | Timeout Configuration

Source >

Name FlexCAN Custom name [_]

iz Import..

i Export.. 0 FlexCAN Hardware Channel FLEXCAN_O A

Build Project 1
Clean Project

Refresh Fs Mumber Of MB |16

Close Project
Close Unrelated Project 8 Rx FIFO Filters

Enable Legacy RxFiFO O
Enable FD Can
FlexCAN operation modes Normal mode or user mode b I

Name |FlexcAN_Configo

Build Targets
Index
Build Configurations

Build path
Build Configurations Explorer Payload Size (bytes) 8

o Choose “Normal mode or user mode”

Migrate...

Show in Remote Systems view

O RunAs >
4 Debug As > Enable EnhancedCET Can

Restore from Local History. Enable BitRate Switch
# 532 Configuration Tools 3| ® OpenPins
Can FD ISO

Team 1 Open Clocks

>
Compare With ¥ _OpenPeripherals [ Auto Bus Off
>
>

- * Open DCD
Configure o e Remote Request Store
Source - P

¥ Validate & Open QuadSPI
@ Open DDR
Properties Alt+Enter Import Configuration (*.mex)
Manage SDK Components 4 1

OoOoOoog e



HANDS ON CAN: CAN CONFIGURATION 2
Configure the BaudRate as 500Kbps for FlexCANO

- TimeQuantum (seconds) = Prescaler / CanClockFrequency
- No. of CanTimeQuantas = (1 / CancontrollerBaudRate) / TimeQuantum
- No. of CanTimeQuantas = 1 + CanControllerPropSeg + CanControllerSegl + CanControllerSeg2

FlexCAN Protocol Clock 40000000
“ FlexCAMN bitrate

Mame FlexCAN_lp_TimeSeg0

Synchronization segment

Propagation segment
Phase segment 1

Phase segment 2
Prescaler division factor
Resync jump width

1
7
5
4
L
Bitrate (Kbps) TI

Sampling point (%) Fi

Lo |



HANDS ON CAN: CAN CONFIGURATION 3

Add FlexCANL1:
- Right-click the Project,
- Select S32 Configuration Tools
- Select Open Peripherals

nl Includes

@ Project_Se

~ B sre

= maimn.c

2
H de
k]

B X

o

New
Ga Into

Open in New Window
Show In

Show in Local Terminal
Copy

Delete

Paste

Rename...

Source

Import...

Export...

Build Project

Clean Project

Refresh

Close Project

Close Unrelated Project
Build Targets

Index

Build Configurations
Build path

Build Configurations Explorer
S5DKs

Migrate...

Show in Remote Systems view
Run As

1 Debug As

b

Restore from Local History...

Alt+Shift+W

Ctri+C
Delete
Ctri+V

F2

F5

>

>

532 Configuration Togls

Team
Compare With
Configure
Source
Validate

Properties

Alt+Enter

Open Pins
Open Clocks

Open Peripherals |

S UmElEs ®

Qpen DCD

Open VT

Open Quad5SPI

Open DDR

Import Configuration (*.mex)
Manage SDK Components
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HANDS ON CAN: CAN CONFIGURATION 4

Add FlexCAN1:

Double-click FlexCAN component

Click on plus button to add FlexCAN_1

Set Clock as 40MHz for FlexCAN_1
Set Bitrate as 500kbps

e Components &2+’ Peripherals = 0O

[type filter text

] ovs

@

IP FlexCAN Driver pivers
Name FlexCAN

Mode General Mode

B @
Custom name []

w

Preset :Custo m. “

TimeStamp Time

FlexCAN Protocol Clock
~ FlexCAN bitrate

TimeStamp HR Capture Con

Name | Config Time Support |FlexCAN config FlexCAN 1| Timeout Config
%I~ Add FlexCAN_1
0 FlexCAN Hardware Channel | IrLexcan 1 v
I Name |FlexCAN_Configt
Number Of MB [16
FlexCAMN Rx FIFO filters number _8 Rx FIFO Filters
Enable Legacy RxFIFO O
Enable FD Can O
FlexCAN operation modes _Non'nal mode or user mode v
Payload Size (bytes) 8 v
Rx FIFO Transfer Type _Uswng interrupts
A Channel Used 0
Enable EnhancedCBT Can O
Enable BitRate Switch O
Can FD ISO O
Auto Bus Off
Remote Request Store O
TimeStamp Free Runing Timer Source |Captured time base is CAN bit clock.

|Message buffer time stamp base is TIMER.

] _The high resolution time stamp capture is disabled. Enable Timer Source Set C I OCk

Ja0000000 |

Name

Synchronization segment
Propagation segment
Phase segment 1

Phase segment 2
Prescaler division factor
Resync jump width
Bitrate (Kbps)

Sampling point (%)

|FlexcAN_Ip_Timeseg1

|5 SDCL Dithalttc
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HANDS ON CAN: UPDATE CODE

W workspace53205.3.4 - FlexCAN_|p_Example_532G399A_M7/description.txt - 532 Design Studio for 532 Platform

Generate code method:

1. Open the view of any configuration tool, like
Pins, then click Update Code (ensure desired
project is selected)

2.The Update Files window pops up. It shows

the detailed update information. Click OK button.

3.The configuration .c and .h files will be
generated at “generate” folder.

File Edit Navigate Search Project ConfigTools Peripherals
M-k E| I‘-IexCAN_Ip_Example_SSEG?-E?fﬂ_h@

Run Window Help

A B Update Code ~

' Functional Group

B8 update Files O
Generated file | Status |
-4 Pins

- [ board), .
HE siul2_Port_lp_Cfg.c Enable Pins. Bl create
[ Siul2_Port_Ip_Cfg.h Bl create
- [ Clocks @ error
- [ generate’,
= include
B Clock_Ip_BOARD _InitPeripherals_PBcfg.h Bl create
A Clock_Ip_Cfg.h create
Clock_Ip_Cfg_Defines.h B create
- [ generate’,
=& src
2t m s e VLA DY feiaMm i b e e A e - [~
Options @
OK Cancel

[~] Always show details before Update Code

v =5 FlexCAN_Ip_Example_S32G399A_M7: Debug RAM
») Includes
& Project_Settings

& RTD
& board
& generate

v (& generate/include
[n Clock_Ip_BOARD_InitPeripherals_PBcfg.h
[n Clock_Ip_Cfg_Defines.h
I8 Clock_Ip_Cfg.h
i FlexCAN_Ip_Cfg.h
In FlexCAN_Ip_CfgDefines.h
in FlexCAN_Ip_Sa_BOARD_InitPeripherals_PBcfg.h
{8 IntCtrl_lp_Cfg.h
[nl IntCtrl_lp_CfgDefines.h
th modules.h
{8 Oslf_ArchCfg.h
W Osif_Cfg.h
in Siul2_Port_lp_Defines.h
v & generate/src
|5 Clock_Ip_BOARD_InitPeripherals_PBcfg.c
lg Clock_Ip_Cfg.c
I FlexCAN_Ip_Sa_BOARD_InitPeripherals_PBcfg.c
i IntCtrl_lp_Cfg.c
lg Oslf_Cfg.c

SIC
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HANDS ON CAN: APPLICATION CODE 1

Modify the main.c:

15 /* Including necessary configuration files. */
16 #include "Mcal.h"

17 #include "Clock_Ip.h"

18 #include "FlexCAN_Ip.h"

19 #include "IntCtrl _Ip.h"

20 #include "check_example.h"

21
zzl #include "Siul2 Port Ip.h" |
2

24 #define FLEXCANO@_INST oU

25 #define FLEXCAN1_INST 1U

26 #define MSG_ID 20u

27 #define RX_MB_IDX 1U

28 #define TX_MB_IDX @U

29 volatile int exit_code = 0;

30 /* User includes */

31 uint8 dummyData[8] = {1,2,3,4,5,6,7};

325 /*!

33 \brief The main function for the project.

Add the Port includes and
Port initialization function

34 \details The startup initialization sequence 1S The Tollowing:

35 * - startup asm routine
36 * - main()

2 T Al 4

18 extern void CANO@_ORED_©_7_MB_IRQHandler (void);
39 extern void CAN1_ORED_©_7_MB_IRQHandler(void);

49

41- int main(void)

a2 {

43 /* Write your code here */

a4 Clock_Ip_Init(&4cu_aClockConfigPB[0]);

a5

46 I Siul2 Port_Ip_Init(NUM_OF_CONFIGURED_PINS®, g pin_mux_InitConfigArre); I

a7

a8 IntCtrl_Ip_EnableIrq(CANO_ORED ©6_7 MB_IRQn);

49 | IntCtrl_Ip_InstallHandler(CAN@ ORED @ 7 MB_IRQn, CAN®_ORED_©_7_MB_IRQHandler, NULL_PTR);
50

51 IntCtrl_Ip_EnableIrq(CANI_ORED ©6_7 MB_IRQn);

52 IntCtrl_Ip_InstallHandler(CAN1_ORED @ _7 MB_IRQn, CAN1_ORED_@_7_MB_IRQHandler, NULL_PTR);
53

15 /* Including necessary configuration files. */
16 #include "Mcal.h"

17 #include "Clock_Ip.h"

18 #include "FlexCAN_Ip.h"

19 #include "IntCtrl_Ip.h"

20 #include "check_example.h"

22 #include "Siul2_Port_Ip.h"

26 #define MSG_ID 20u

27 #define RX_MB_IDX 1U

28 #define TX_MB_IDX OU

29 volatile int exit_code = 0;
30 /* User includes */

31 uint8 dummyData[8] = {1,2,3,4,5,6,7};

328 /*]

33 \brief The main function for the project.

34 \details The startup initialization sequence is the following:
35 * - startup asm routine

36 * - main()

37 %

28 extern void CANO ORED © 7 MB_IRQHandler(void);

39 —
40

41- int main(void)

Instance

racrine o mer | Redefine the FlexCAN

Enable Interrupt and Install
Handler for FlexCAN_1

42 {

43 /* UWrite your code here */

44 Clock_Ip_Init(&Mcu_aClockConfigPB[@]);

45

46 Siul2_Port_Ip_Init(NUM_OF_CONFIGURED_PINS@, g _pin_mux_InitConfigArr@);

47

48 IntCtrl_Ip_EnableIrq(CAN@_ORED _©_7 MB_IRQn);

49 IntCtrl_Ip InstallHandler(CANO_ORED_@_7 MB_IRQn, CAN@_ORED_@_7_MB_IRQHandler,JNULL_PTR);
50

51 IntCtrl_Ip_EnableIrq(CAN1_ORED_©_7 MB_IRQn);

52 IntCtrl_Ip_InstallHandler(CAN1_ORED @ _7 MB_IRQn, CAN1_ORED_@_7_MB_IRQHandler, NULL_PTR);
53
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HANDS ON CAN: APPLICATION CODE 2

Modify the main.c:

Flexcan_Ip_DataInfoType rx_info = {
.msg_id type = FLEXCAN MSG_ID STD,
.data_length = B8u,
.is_polling = TRUE,
.is_remote = FALSE
hiF
Flexcan_Ip MsgBuffType rxData;
FlexCAN_Ip Init(FLEXCAN® _INST, &FlexCAN_State@, &FlexCAN_Config@);
FlexCAN_Ip_SetStartMode(FLEXCAN®_INST);

FlexCAN_Ip_SetStartMode(FLEXCAN1_INST);

rx_info.is_polling = FALSE;

FlexCAN_Ip Receive(FLEXCAN1_INST, RX_MB_IDX, &rxData, TRUE);
while(FlexCAN_Ip GetTransferStatus(FLEXCAN1_INST, RX_MB_IDX) != FLEXCAN STATUS_SUCCESS)
{ FlexCAN_Ip_MainFunctionRead(FLEXCAN1_INST, RX_MB_IDX); }

FlexCAN_Ip_ SetStopMode(FLEXCAN® _INST);
FlexCAN Ip SetStopMode(FLEXCANL1_INST);
FlexCAN_Ip Deinit(FLEXCAN@_INST):
FlexCAN_Ip Deinit({FLEXCAN1_INST);

Exit_ Example(TRUE);

FlexCAN_Ip_Init(FLEXCAN1_INST, &FlexCAN_Statel, &FlexCAN_Configl);| |nitialize FlexCAN 1 Controller

FlexCAN_Ip_ConfigRxib (FLEXCAN1_INST, RX_MB_IDX, &nx_info, MS6_ID);| Configure Rx MailBox for FlexCAN_1

FlexCAN_Ip_Send(FLEXCAN® INST, TX MB_IDX, &rx_info, MSG_ID, (uint8 *)&ummyData);] FIEXCANO send the message

FlexCANL1 receive the message
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HANDS ON CAN: BUILD AND DEBUG 1

Build target Project:

») Includes

& Project_Settings

& RTD
&2 board
& generate

&2 generate/include

& generate/src
& src

i€ main.c
& Debug_RAM
&4 include

/ gescnption.ixt

i Ly
B FlexCAN e

t

ample (

Right-click the Project
Build Project
The console will print build information

FlexCAN_Ip_Example S32G399A M7.elf is created

v 15 FlexCAN _Ip_Example_S32G.
v & Binaries
%> FlexCAN_Ip_Example_S

T.mes

=R §

K|

b

&

New
Go Into

Open in New Window

Show In

Show in Local Terminal

Copy
Delete
Paste
Rename...
Source
Move..

Import...
Export...

Build Project

Clean Project

Alt+Shift+W >
>

Ctri+C
Delete
Ctri+V

F2

v = FlexCAN_Ip_Example_S32G399A_M7: Debug RAM
v & Binaries
%5 FlexCAN_Ip_Example_S32G399A_M7.elf - [arm/le]
») Includes
& Project_Settings
& RTD
2 board
&} generate
&2 generate/include
(5 generate/src
v @B src
i€ main.c
= Debug_RAM

(

wiude

2 Console 22 Properties Search =g Progre i Debug 5= Call Hiera
CDT Build Console [FlexCAN_Ip_Example_S32G399A_M7]
16:31:58 **** Incremental Build of configuration Debug_RAM for project Flex
make -3j8 all
Invoking: Standard $32DS Print Size
arm-none-eabi-size --format=berkeley FlexCAN_Ip_Example_S32G399A M7.elf

text data bss dec hex filename
305960 @ 12289 318249 4db29 FlexCAN_Ip_Example_S32G399A_M7.elf

Finished building: FlexCAN_Ip_Example_S32G399A_M7.siz

16:32:01 Build Finished. @ errors, @ warnings. (took 2s.690ms)
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HANDS ON CAN: BUILD AND DEBUG 2

Debug configuration setting:
- Connect the S32 Debug probe with PC and RDB3

Go to debug configuration:
- Right-click the Project
- Select the Debug As
- Click on Debug Configurations

LS FlexCANIp EXa  new >
# Binaries Go Into
») Includes

& Project_Settin Open in New Window
4 RTD Show In Alt+Shift+W >

8 board Show in Local Terminal >
& generate & Copy Ctri+C
! generate/incl ¥ Delete Delete
& generate/src [ Paste Ctri+V
v @ sre ™ Rename.. F2
(8 main.c Source g
& Debug_RAM Mov
! s Import...
- “ &4 Export.
% Build Project
Clean Project
Refresh F5

Close Project
Close Unrelated Project

Build Targets >
Index >
Build Configurations >
Build path >
Build Configurations Explorer
SDKs
Migrate...
Show in Remote Systems view
O RunAs >
1 Debug As 3 [€] 1Llocal C/C++ Application
Restore from Local History... 2 532DS C/C++ Application
$32 Configuration Tools > Debug Configurations...
Team >
Compare With >
Configure >
Source >
¥l Validate
Properties Alt+Enter

- Click on target project

- Select the target device and core as S32G399A M7_0
- Select target S32 Debug Probe

ter text

~ [€] C/C++ Application
[€] FlexCAN_Ip_Example_S32G399A_M7.elf
[€] C/C++ Remote Application
© Eclipse Application
[€] GDB Hardware Debugging
[E GDB PEMicro Interface Debugging
[€] GDB SEGGER J-Link Debugging
& Launch Group
# Launch Group (Deprecated)
¥ Launch Group for S32 Debugger

v S$32 Debugger
I FlexCAN_Ip_Example_S32G399A_M7_Debug_RAM_S32Debug I

$32 Debugger Flash Programmer
VLAB Simulator Debugging

Name: | FlexCAN_Ip_Example_S32G399A_M7_Debug_RAM_S32Debug

Main | % Debugger ¥ Startup| %~ Source =] Common| !i!i SVD Support| # OS Awareness| 3 Trace and Profile

Hardware
Device: S32G399A Core: M7_OI Select device and core
Initialization script: | ${S32DS_INITIALIZATION_SCRIPTS_DIR}/s32g3xx/s32g3xx_generic_bareboard.py Browse.. Variables...

Initial core

Debug Probe Connection

Interface: $32 Debug Probe - USB v
USB device: 00:04:91:06:6d:1e - S32 Debug Probe

<

Refresh ' Test connection

Hostname or IP:

Target Communication Speed

JTAG Speed (KHz): | 16000 Timeout: |30 s
[[] Delay after reset: 0 ms

GDB Server

Launch server

Server port number®| 45000

[J€enable log
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HANDS ON CAN: DEBUG AND RUN

Power on the RDB3, click on “Apply”, then click on “Debug”. The view will switch to the Debug Perspective,
and you can use the controls to control the program flow.

Name: |FlexCAN_Ip_Example_S32G399A_M7_Debug_RAM_S32Debug File Edit Source Refactor Navigate Search Project ConfigTools Run FreeRTOS Window Help
= = ~ - = . - Q i o ' 5 | P»1 - 2 i  { '3 A Y
[5) Main | %2 Debugger », ¥ Startup| &+ Source, ] Common | 'i!f SVD Support| 88 OS Awareness| & Trace and Profile L3t | @il N i LS. BrOvQR v OO Jv  $0vHle0Cw f
Hardware - 1% Debug 2 Pr Explore = 0 [dmainc @ Iy Siul2_Port Ip_Cfgh  [€10x34020404 i S32G399A_COMMON.h
Device: $32G399A Core: M7_0 Select device and core B % 3| > 3 29 volatile int exit_code = 0;

v = FlexCAN_Ip_Example_S32G399A_M7_Debug RAM 9 /* User includes */

itializati i INI PT! i .| s i - pes 3 i = =
|I'Iltli.\l-latlol'l script: |$|53ZDS_ INITIALIZATION_SCRIPTS_DIR}/s32g3xx/s32g3xx_generic_bareboard.py Browse.. Variables. v I FlexCAN_Ip_Example_S32G399A MT.elf (1] [co 1/ l/l}f'\ts dummyData[8] = {1,2,3,4,5,6,7};
Ed nitial core v o Thread #1 1 [core: 0] (Suspended : Breakpoi 33 &hriz’f The main function for the project.
Debug Probe Connection = main() at main.c:44 0x340001e0 34 \details The startup initialization sequence is the following:
Interface: 532 Debug Probe - USB ~ wi C/NXP/S32DS.3.4/532DS/tools/gdb-arm/arm3 35 * - startup asm routine
USB device: | 000491066t Te - 532 Debug Probe Refresh | Test connecti i SIAD G R
evice: : :1e rol efres| connection 8 Semihosting 37 =/
Hostname or IP: 8 extern void CAN@_ORED_©_7_MB_IRQHandler(void);
19 extern void CAN1_ORED_©_7_MB_IRQHandler(void);
Target Communication Speed 40
JTAG Speed (KHz): | 16000 Timeout: 30 s 41 ~int main(void)
) B2 {
[]Delay after reset: |0 L= 43 /* Write your code here */
GDB Server Clock_Ip_Init(&Mcu_aClockConfigPB[0]);
Launch server i3 § 2 i 2 s
46 Siul2_Port_Ip_Init(NUM_OF_CONFIGURED_PINS@, g_pin_mux_InitConfigArr@);
Server port number®| 45000 47
[JEnable log 8 IntCtrl_Ip_EnableIrq(CANG_ORED_©_7 MB_IRQn);
G a0 IntCtrl_Ip_InstallHandler(CANG_ORED_©_7_MB_IRQn, CANO@_ORED_@_7_MB_IRQHandler, NULL_PTR);
3
Executable: | ${S32DS_GDB_ARM32_PY} Select |Browse.. Variables.. 51 IntCtrl_Ip_EnableIrq(CAN1_ORED 0_7 MB_IRQn);
Commands: ‘»/ IntCtrl_Ip_InstallHandler(CAN1_ORED_©_7_MB_IRQn, CAN1_ORED_@_7_MB_IRQHandler, NULL_PTR);
53
‘ui Flexcan_Ip_DatalnfoType rx_info = {
e §s5 .msg_id_type = FLEXCAN_MSG_ID_STD,
6 .data_length = 8u,
Revert is7 .is_polling = TRUE,
58 .is_remote = FALSE
§>° Y
Debug Close ‘
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HANDS ON CAN: TEST RESULT

Add a breakpoint to the FlexCAN_Ip_SetStopMode function, then click on the Resume option. The received

CAN frame can be watched from rxData.

workspace$32D5.3.4 - FlexCAN _S32G399A_M7/src/main.c - $32 Design Studio for 532 Platform

File Edit Source Refactor Navigd fearch Project ConfigTools Run FreeRTOS Window Help

v @@ B0 D\E . i SO R e®™ ) R e [

1% Debug 2 = 0 [gmainc 2 ]

= i 3 Jas

v FlexCAN_Ip_Example_S32G399A_M7_Debug_RA

¥ FlexCAN_Ip_Example_S32G399A_M7.elf [1] [col

v o Thread #1 1 [core: 0] (Suspended : Breakpoi
= main() at main.c.76 0x3400027e ¢

wi C/NXP/S32DS.3.4/S32DS/tools/gdb-arm/arm3 1 IntCtrl_Ip_EnableIrg(CAN1_ORED_@_7_MB_IRQn);

»i S32 Debugger 52 IntCtrl_Ip_InstallHandler(CAN1_ORED_©_7_MB_IRQn, CAN1_ORED_©_7_MB_IRQHandler, NULL_PTR);

» Semihosting 53

Siul2_Port_Ip_Init(NUM_OF_CONFIGURED_PINS®, g_pin_mux_InitConfigArr@);

<

IntCtrl_Ip_EnableIrq(CAN@_ORED_©_7_MB_IRQn);
IntCtrl_Ip_InstallHandler(CAN@_ORED_©_7_MB_IRQn, CANO@_ORED_©_7_MB_IRQHandler, NULL_PTR);

Flexcan_Ip_DataInfoType rx_info = {
.msg_id_type = FLEXCAN_MSG_ID_STD,
.data_length = 8u,
.is_polling = TRUE,
.is_remote = FALSE
b
Flexcan_Ip_MsgBuffType rxData;
FlexCAN_Ip_Init(FLEXCAN@_INST, &FlexCAN_State®, &FlexCAN_Config@);
FlexCAN_Ip_SetStartMode (FLEXCAN@_INST);

FlexCAN_Ip_Init(FLEXCAN1_INST, &FlexCAN_Statel, &FlexCAN_Configl);
65 FlexCAN_Ip_SetStartMode (FLEXCAN1_INST);

FlexCAN_Ip_ConfigRxMb(FLEXCAN1_INST, RX_MB_IDX, &rx_info, MSG_ID);
rx_info.is_polling = FALSE;

FlexCAN_Ip_Send(FLEXCAN@_INST, TX_MB_IDX, &rx_info, MSG_ID, (uint8 *)&dummyData);
FlexCAN_Ip_Receive(FLEXCAN1_INST, RX_MB_IDX, &rxData, TRUE);

while(FlexCAN_Ip_GetTransferStatus(FLEXCAN1_INST, RX_MB_IDX) != FLEXCAN_STATUS_SUCCESS)
{ FlexCAN_Ip_MainFunctionRead(FLEXCAN1_INST, RX_MB_IDX); }

876 FlexCAN_Ip SetStopMode (FLEXCAN® INST);
] FlexCAN_Ip_SetStopMode (FLEXCAN1_INST);
FlexCAN_Ip_Deinit(FLEXCAN@_INST);
FlexCAN_Ip_Deinit(FLEXCAN1_INST);
Exit_Example(TRUE);

< >

# Dashboard @ § =0

~ Project Creation

Application Project

-

X

Q nEEMtsEs @

U check_example.h

o Siul2_Port_Iph

# FLEXCANO_INST

# FLEXCAN1_INST

# MSGID

# RX_MB_IDX

# TX_MB_IDX

" exit_code

® dummyData
CANO_ORED_0_7_MB_IRQHandler(void)
CAN1_ORED_0_7_MB_IRQHandler(void)

Note: Make sure FlexCAN_0 connect to FlexCAN_1 via physical wiring

"u = O =Variables 7 % Breakpoi.. % Expressio.. ® Modules il Periphera.. Ml Arm Syst... EmbSys.. 7 Peripherals = O
" B 8
Name Type Value "
** n_info Flexcan_lp_DatalnfoType {.}
v (% xData Flexcan_lp_MsgBuffType (-}
- cs uint32 34078855
= msgld uint32 20
v (® data uint8 [64] 0x34401fb0
)= data[0] uint8 1\001"
- data[1] uint8 2002
= data[2] uint8 3\003
- data(3] uint8 47004
- data(4] uint 51005
0= data(5] uint8 6 \006"
4+ data[6] uint8 7\a
W aatars; ume LAWY
0= data([8] uint8 oo
- data[9] uint8 0"\0
)= data[10] uint8 0\
- data[11] uint8 010
- data[12] uint8 00
= data[13] uint8 on\o
- dataf14] uint8 0\0' M
< >
Name : data[@]
2 Outline ¢ SRR o % =
o IntCtrl_lph 2

51

Lo |



SECURE CONNECTIONS
FOR A SMARTER WORLD




LEGAL INFORMATION

- Definitions

Draft — A draft status on a document indicates that the content is still under internal review and subject to formal approval, which may result in
modifications or additions. NXP Semiconductors does not give any representations or warranties as to the accuracy or completeness of
information included in a draft version of a document and shall have no liability for the consequences of use of such information.

- Disclaimers

Limited warranty and liability — Information in this document is believed to be accurate and reliable. However, NXP Semiconductors does not
give any representations or warranties, expressed or implied, as to the accuracy or completeness of such information and shall have no liability for
the consequences of use of such information. NXP Semiconductors takes no responsibility for the content in this document if provided by an
information source outside of NXP Semiconductors.

In no event shall NXP Semiconductors be liable for any indirect, incidental, punitive, special or consequential damages (including - without
limitation - lost profits, lost savings, business interruption, costs related to the removal or replacement of any products or rework charges) whether
or not such damages are based on tort (including negligence), warranty, breach of contract or any other legal theory.

Notwithstanding any damages that customer might incur for any reason whatsoever, NXP Semiconductors’ aggregate and cumulative liability
towards customer for the products described herein shall be limited in accordance with the Terms and conditions of commercial sale of NXP
Semiconductors.

Right to make changes — NXP Semiconductors reserves the right to make changes to information published in this document, including without

limitation specifications and product descriptions, at any time and without notice. This document supersedes and replaces all information supplied
prior to the publication hereof.
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LEGAL INFORMATION

Applications — Applications that are described herein for any of these products are for illustrative purposes only. NXP Semiconductors makes no
representation or warranty that such applications will be suitable for the specified use without further testing or modification.

Customers are responsible for the design and operation of their applications and products using NXP Semiconductors products, and NXP
Semiconductors accepts no liability for any assistance with applications or customer product design. It is customer’s sole responsibility to
determine whether the NXP Semiconductors product is suitable and fit for the customer’s applications and products planned, as well as for the
planned application and use of customer’s third party customer(s). Customers should provide appropriate design and operating safeguards to
minimize the risks associated with their applications and products. NXP Semiconductors does not accept any liability related to any default,
damage, costs or problem which is based on any weakness or default in the customer’s applications or products, or the application or use by
customer’s third party customer(s). Customer is responsible for doing all necessary testing for the customer’s applications and products using NXP
Semiconductors products in order to avoid a default of the applications and the products or of the application or use by customer’s third party
customer(s). NXP does not accept any liability in this respect.

Terms and conditions of commercial sale — NXP Semiconductors products are sold subject to the general terms and conditions of commercial
sale, as published at http://www.nxp.com/profile/terms, unless otherwise agreed in a valid written individual agreement. In case an individual
agreement is concluded only the terms and conditions of the respective agreement shall apply. NXP Semiconductors hereby expressly objects to
applying the customer’s general terms and conditions with regard to the purchase of NXP Semiconductors products by customer.

Suitability for use in automotive applications — This NXP product has been qualified for use in automotive applications. If this product is used
by customer in the development of, or for incorporation into, products or services (a) used in safety critical applications or (b) in which failure could
lead to death, personal injury, or severe physical or environmental damage (such products and services hereinafter referred to as “Critical
Applications”), then customer makes the ultimate design decisions regarding its products and is solely responsible for compliance with all legal,
regulatory, safety, and security related requirements concerning its products, regardless of any information or support that may be provided by
NXP. As such, customer assumes all risk related to use of any products in Critical Applications and NXP and its suppliers shall not be liable for
any such use by customer. Accordingly, customer will indemnify and hold NXP harmless from any claims, liabilities, damages and associated
costs and expenses (including attorneys’ fees) that NXP may incur related to customer’s incorporation of any product in a Critical ApplicationJ{



LEGAL INFORMATION

Export control — This document as well as the item(s) described herein may be subject to export control regulations. Export might require a prior
authorization from competent authorities.

Translations — A non-English (translated) version of a document, including the legal information in that document, is for reference only. The
English version shall prevail in case of any discrepancy between the translated and English versions.

Security — Customer understands that all NXP products may be subject to unidentified vulnerabilities or may support established security
standards or specifications with known limitations. Customer is responsible for the design and operation of its applications and products
throughout their lifecycles to reduce the effect of these vulnerabilities on customer’s applications and products. Customer’s responsibility also
extends to other open and/or proprietary technologies supported by NXP products for use in customer’s applications. NXP accepts no liability for
any vulnerability. Customer should regularly check security updates from NXP and follow up appropriately.

Customer shall select products with security features that best meet rules, regulations, and standards of the intended application and make the
ultimate design decisions regarding its products and is solely responsible for compliance with all legal, regulatory, and security related
requirements concerning its products, regardless of any information or support that may be provided by NXP.

NXP has a Product Security Incident Response Team (PSIRT) (reachable at PSIRT@nxp.com) that manages the investigation,reporting, and
solution release to security vulnerabilities of NXP products.

- Trademarks
Notice: All referenced brands, product names, service names, and trademarks are the property of their respective owners.
NXP — wordmark and logo are trademarks of NXP B.V.
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